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Abstract In this paper, scanning electron microscopy
(SEM) images of carbon samples were analysed, and some
textural characteristics were obtained and compared with
those determined using mercury porosimetry data. Fractal
dimensions were calculated from both mercury porosime-
try and SEM images as methods for characterising the
porous distribution (heterogeneity) of the samples. Lacunarity
is easily determined from SEM images as a measure of the
degree of heterogeneity of a porous surface. A relationship
between the lacunarity and the fractal dimensions calcu-
lated using both methods is shown. Pore-size distributions
were also determined from the analysis of SEM images.
We show that the analysis of SEM images is a valuable
complement to mercury porosimetry measurements and a
useful tool for the characterisation of porous surfaces. This
method offers the possibility of evaluating the features
of porous materials and comparing the results to those
obtained using mercury intrusion analysis.
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1 Introduction

Fractal dimension theory (Mandelbrot 1975) is a useful
tool for the characterisation of the structure of porous
materials. This theory is based on the concept of self-
similarity. An object is self-similar if its appearance does
not depend on the scale at which it is observed. Intrusion
mercury volume data can be processed in the context of
fractal theory (Mahamud et al. 2003), thereby allowing a
recently used parameter, the fractal dimension (Gaspard
et al. 2000), to be determined. In this paper, the fractal
dimensions of ten activated carbon samples was calculated
from mercury porosimetry data based on the method pre-
sented by Mahamud and Novo (2008). To estimate the
fractal dimension from mercury porosimetry data, the lin-
ear increase in the mercury cumulated volume due to
compression rather than intrusion when pressure is applied
to a material was considered (Passé-Coutrin et al. 2005).

The weakness of such indirect methods is that they are
based on mathematical models that do not always match
with observed behaviour of activated carbons. For exam-
ple, mercury porosimetry theory assumes an idealised
cylindrical pore model as the basis for estimating the
average pore width of activated carbons. However, scan-
ning electron microscopy (SEM) micrograph observations
have shown that this model does not always reflect the
complex nature of porosity in activated carbons. Further-
more, the fractal dimension generally exhibit different
values depending on the method used (Tatlyer and Erdem-
Suenatalar 1999; Gauden et al. 2001).

Scanning electron microscopy is a direct method that is
useful for the characterisation of the textural structure of
pores (Ball and McCartney 2011; Achaw and Afrane
2008). The standard SEM image represents a two-dimen-
sional (2D) structure from which mostly qualitative data
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can be extracted. 2D SEM cannot be used to observe the
three-dimensional (3D) porosity of the materials because
conventional SEM instruments cannot observe the inner
parts of a material. Therefore, a precise description that
represents the 3D pore structure is difficult. Nevertheless,
this method is easy to apply, and data obtained from the
observed images can be improved through the use of
appropriate image-processing methods. Fractal dimensions
are sometimes insufficient to characterise the heterogeneity
of samples because different textures can exhibit similar
fractal dimensions. Such estimations can be improved
through the use of the lacunarity (Kilic and Abiyev 2011),
which can be obtained from SEM images and which gives
a measurement of the heterogeneity of holes between pores
in the surface of activated carbon.

Given the previously described advantages and draw-
back of SEM and mercury porosimetry, we propose to use
these direct and indirect methods, respectively, as alter-
native methods for obtaining information about the textural
characteristics of porous materials. This study is focused on
combining fractal dimension and lacunarity data obtained
from 2D SEM images to provide new insight into the
texture of porous materials and to allow a comparison of
the results with those from mercury porosimetry data.

The pore-size distribution (PSD) function is usually
used as a quantitative characteristic of the porous structure
of solid adsorbents with respect to their heterogeneity. The
PSD function of a porous medium is perhaps the most
important characteristic because it influences the transport
of sorbates in the structure. In this study, we compare the
PSDs obtained from mercury porosimetry and SEM ima-
ges. This analysis will contribute not only to the search for
alternative methods to characterise the distribution of the
pores but also to search for information that can reduce
the uncertainties related to the texture characterisation of
the material.

In the method presented here, fractal dimensions, PSDs
and lacunarities from SEM images were determined on the
same set of experimental data. Fractal dimension values
obtained either from SEM analysis or from mercury
porosimetry are compared. The relationship between the
lacunarity and the fractal dimension are discussed. In
addition, we discuss the differences between the two
concepts.

2 Materials and methods
2.1 Preparation of carbon samples
The samples studied here were prepared from different

precursors: Posidonia oceanica (a marine biomass), sugar
cane bagasse and vetiver roots. Preparation chars from raw
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P. oceanica fibres were prepared by the carbonisation of
the fibres at 300 and 400 °C, which resulted in samples
PosPyr300 and PosPyr400, respectively. Posidonia oceanica
fibres were also pyrolysed at 600 °C during 1 h, the carbon
sample obtained was further activated by steam for 20, 120
and 300 min giving samples PAC20, PAC120 and PAC300,
respectively (Ncibi et al. 2009). Activated carbon samples
obtained by chemical activation were prepared by phos-
phoric acid impregnation of either bagasse or vetiver roots in
H5PO, (85 %) for 24 h followed by pyrolysis at 600 °C.
Impregnation ratios, Xp (g H3PO4/g precursor), of 0.5:1; 1:1
and 1.5:1 were used to produce samples VetP0.5, VetPl,
VetP1.5, BagP0.5 and BagP1, respectively (Altenor et al.
2009). The complete procedures for the preparations of
carbons and the corresponding textural characteristics are
described in detail elsewhere (Passé-Coutrin et al. 2008;
Altenor et al. 2009; Ncibi et al. 2009).

2.2 Scanning electron microscopy

A SEM equipped with an energy-dispersive X-ray micro-
analyser (Hitachi S-2500) was used to determine the sur-
face textural characteristics. The char samples were first
mounted on an aluminium stub. The microscope was
operated at an accelerating voltage of 200 kV and at a
working distance of 35 mm. Utilising the ImageJ software
(http://rsbweb.nih.gov/ij), we obtained quantitative infor-
mation from 2D SEM images of activated carbon samples.
However, this process involves a number of challenges.
These include the sample preparation, the scanning pro-
cess, the image formation and the image analysis. The
quantitative data are the pore-structure, the pore sizes, the
pore shapes, the pore surface area and the PSD, which are
most useful data for characterisation. Because of the
complexity of the system studied, a complete analysis must
be performed together with the qualitative analysis.

2.3 Determination of fractal dimensions, lacunarities
and pore-size distributions from SEM images

The analysis of SEM images was performed using the
Image] software developed for direct qualitative and
quantitative images analysis. ImageJ is a public domain,
Java-based image processing program developed at the
National Institutes of Health.

This software allows preprocessing of the image via
several filters and, scale adjustments, to enable the selec-
tion of the best part of the image; and finally, a binarisation
is performed. Fractal dimension Dgg;, was determined by
using the box-counting method. Lacunarity was calculated
by the sliding box method. This procedure was applied to
the images in Figs. 1 and 2, which were processed in a
manner similar to that reported by Gun’ko et al. (2012).
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Fig. 1 SEM micrographs of carbon samples prepared from Posidonia oceanica. Each micrograph represents a fragment of the porous surface

Lacunarity measures heterogeneity. This quantity was
designed to complement fractal analysis when fractal
dimension values are similar (Mandelbrot 1975, 1983), i.e.,
to show qualitative differences in the mass distribution, or
differences in the amount of holes. The determination of
the lacunarity is based on pixel masses instead of box
counts. The word “lacunarity” literally refers to a gap or
pool, as derived from the word for “lake”; however, in
morphological analysis, it has been variously defined as
gappiness, visual texture, inhomogeneity, translational and
rotational invariance, etc. Allain and Cloitre (1991) defined
quantitatively lacunarity as the mean-square deviation of
the fluctuations of the mass distribution function divided by
its square mean. They also defined it as the width of the
mass distribution function for the set of points, given the
“‘boxsize’’. Therefore, greater values of lacunarity imply
greater heterogeneity because it indicates a wider mass
distribution function for the set points, which, in turn,
means a greater number of different mass values. Usually
denoted as A or A, the lacunarity pertains to both the gaps
and the heterogeneity observed in the ImagelJ software. The
determination of lacunarity values based on box counting
via the gliding-box method is performed using the pixel
distribution (Przemyslaw 2009). To find the pixel

distribution, the number of pixels in each e-sized box in a
grid placed on an image is counted during standard non-
overlapping or overlapping box counting. Then, the lacu-
narity, or A, for each grid of calibre ¢ is calculated from the
standard deviation, o, and mean, , for pixels per box. A A
value exists for each € in each series of grid sizes in each
grid orientation, g, in a set of grid orientations.

ImagelJ is designed with an open architecture that pro-
vides extensibility via Java plugins and recordable macros.
Custom acquisition, analysis and processing plugins can be
developed using ImageJ’s built-in editor and a Java com-
piler. User-written plugins make possible to solve many
image processing and analysis problems, from 3D live-cell
imaging. To produce the PSD from SEM images we fol-
lowed the steps: scaling the images knowing the distance in
micrometer and equivalence in pixel on the image followed
by the command (Analyze>Set Scale), after we preprocess
the image with an appropriate filter, for example (command
Image>Adjust>>) or (command Process>filters), convert-
ing the image to grayscale 8 bit and binarisation (command
Process>binary>make binary). Further, the particles size
analysis (command Analyze>>Analyze particle) and (com-
mand Analyze>> Distribution) which produces a complete
characterization of pore size and amount of pores. Finally
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Fig. 2 SEM micrographs of carbon samples prepared from Posidonia oceanica. Each micrograph represents a fragment of the porous surface

we use the distribution options in the analysis panel that
produces the porous-size distribution according to different
parameter, assuming a circular form of the pores.

Determination of fractal dimension and lacunarity
requires the installation on ImagelJ of the pluggins Fractal
Analysis (http://rsb.info.nih.gov/ij/plugins/index.html). Once
we open the binary image, to produce the fractal dimension
D and lacunarity, we select the command Plugins>Fractal
Analysis. On above mentioned pluggins, we take the Stan-
dard Box Count option to estimate the fractal dimension and
Sliding box lacunarity option for Lacunarity.

2.4 Mercury porosimetry data

Mercury porosimetry of the samples was performed using a
Thermo Finnigan porosimeter, which provides a maximum
operating pressure of 200 MPa. The data obtained con-
sisted of records of the volume of mercury intruded as a
function of pressure. This technique is based on the fact
that mercury does not wet most substances and will
therefore not penetrate pores by capillary action unless it is
forced to do so. Liquid mercury has a high surface tension
and also exhibits a high contact angle against most solids.
Its entry into pore spaces requires the application of pres-
sure in inverse proportion to the pore diameter.

@ Springer

2.5 Fractal dimension from mercury porosimetry data

Estimation of the fractal dimension from the mercury
porosimetry data was performed according to the methods
reported in the literature (Friesen and Mikula 1987; Passé-
Coutrin et al. 2005). The following relationship was used:

dav D,

=

where V is the volume that penetrates the porous medium at
pressure P, and D,,,, is the fractal dimension. This equa-
tion allows a value to be obtained for the fractal dimension,
D00, from the plot In (dV/dP) versus In P. Because coals
are compressible materials, the experimental data from
mercury porosimetry must be corrected prior to their
analysis. To do so, we used the method described by
Mahamud et al. (2003).

3 Results and discussion

Scanning electron microscopy micrographs of small frag-
ments of carbon samples chosen arbitrarily are presented in
Figs. 1 and 2. A cursory examination reveals that the
external porous surfaces of the different carbon fragments
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Table 1 Fractal dimension, lacunarity and minimum and maximum porous size of SEM micrograph from ImageJ software calculations

Carbon sample Fractal Lacunarity Minimum Maximum
dimension Dggy, diameter (um) diameter (pm)

PosPyr300 1.8691 0.1758 3.56 110.6
PosPyr400 1.8481 0,.1528 1.14 20.73
PAC20 1.8549 0.1834 0.33 21.87
PACI120 1.8116 0.2592 0.28 10.64
PAC300 1.8371 0.1605 0.24 4.86
VetP0.5 1.8253 0.2332 3.94 137.4
VetP1 1.8395 0.188 0.24 6.91
VetP1.5 1.8076 0.2827 16.17 232
BagP05 1.8205 0.2062 18.81 359
BagPl 1.8395 0.188 18.81 353.3

exhibit a high porosity but different textures. Pores of some
samples were difficult to distinguish due to different bright-
ness and shadows. These results imply that an appropriate
image preprocessing step is necessary in these cases. The
images were cropped to enable the characterisation of a more
probable texture of the samples.

For chars derived from P. Oceanica (Ncibi et al. 2009),
which were produced under several pyrolysis temperatures,
as the pyrolysis temperature was increased from 300 to
400 °C, the fibrous chars showed more pores in their inner
structures (Fig. 1). Activated carbon samples PAC120 and
PAC20 were slightly obstructed by carbonaceous materials
that were deposited during the cooling period after the
pyrolysis procedure (Ncibi et al. 2009). In this case, a
carefully preprocessing was performed, the pores were well
distinguished in the binarised images.

Figure 2 shows that all the samples exhibit a clearly
developed porous network. In addition, sample VetPl
exhibits macropores and a stripy texture, which made the
surface texture analysis difficult. Some differences in tex-
tures are evident. For example, a comparison of the
BagP0.5, BagP1, VetP05, and VetP1.5 surfaces reveals that
the latter has a more heterogeneous pattern. The SEM
images also show that the pores of BagP0.5 are well
defined compared to those of Vetpl.5. Samples VetP0.5,
BagP1 and BagP0.5 exhibit similar pore size, while sam-
ples VetP1, VetP0.5, PAC120 and PAC20 exhibit wider
pores.

Table 1 gives the data obtained from SEM images
analysis using the ImageJ software, including the fractal
dimensions, the lacunarities, and the minimum and maxi-
mum pore diameters of the porous samples shown in
Figs. 1 and 2. The fractal dimension of the sample shown
in the micrograph in Fig. 1 is between 1 and 2 (Table 1),
which corresponds with the fact that estimates of the 2D
structure of the surface outside of the pores is considered.
Notably, all of the samples exhibit similar fractal dimen-
sions of ~1.8, despite the samples having different

appearances. The structural differences can be discrimi-
nated through the lacunarity. Although low lacunarity
values were obtained in all cases, they were slightly dif-
ferent. Samples with lower lacunarity, such as for Pos-
Pyr400, showed less diversity in pore size (Fig. 1).
However, sample VetPl showed the greatest lacunarity
value, with a spatial distribution that corresponds to a more
heterogeneous texture. Thus, a simple inspection shows
that lacunarity is a valuable parameter in describing small
differences in the spatial distributions of pores.

The lacunarity values were low, which was expected
because all of the samples exhibit high porosity with low
spatial heterogeneity. However, despite the small differ-
ences between the lacunarity values, this parameter reflects
the distinct texture of the samples. The lacunarity value
determined from the SEM micrograph of PosPyr300 is
0.1758, and the texture of the sample differs from that of
VetP0.5, whose SEM micrograph indicates a lacunarity of
0.2332, which indicates a more heterogeneous spatial dis-
tribution of holes.

The minimum and maximum pore diameters are given
in Table 1. These parameters are essential for completing
the characterisation of texture because they show the range
of possible diameters of the pores, which can be different
even if the fractal dimension and lacunarity are similar.
Activated carbon samples VetP1, PAC120, PAC20, and
PAC200 exhibited the lowest values of minimum diameter,
whereas samples BagP05 and BagP1 exhibited the greatest
values.

The highest fractal dimensions observed using mercury
porosimetry D,,,,, (between 2.5 and 2.8) were obtained for
the activated carbons prepared via the phosphoric acid
activation of bagasse and vetiver roots. However, carbons
obtained via the pyrolysis of P. Oceanica exhibited lower
fractal dimensions. The calculation of the fractal dimension
from mercury porosimetry assumes cylindrical pores (Ma-
hamud et al. 2003). A fractal dimension of approximately 3
indicates that the porous system contains many convolutions
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(i.e., twists and turns) that occupy nearly the whole volume,
as is the case of the samples prepared via chemical activation
of bagasse and vetiver roots. A large compressibility may be
linked to thin pore walls. This result appears to be in agree-
ment with the large fractal dimension when the porous sys-
tem is settled in the whole volume (i.e., samples VetPl,
VetP1.5, BagP1, and BagPO0.5).

Figures 3 and 4 show the PSDs obtained from mercury
porosimetry experiments and SEM analyses, respectively.
In the case of mercury porosimetry, the y-axis represents
the percent of intrusion volume for each interval size,
whereas, for SEM analyses, it represents the number of
pores of each pore size (Fig. 4). Based on the pore distri-
bution (Fig. 3), the two activated carbon samples VetPl
and VetP0.5 have porous textures that are different from
those of the BagP0.5 and BagP1 activated carbon samples.

The first correlation noted is that between the lacuna-
rities and the fractal dimensions obtained through SEM
analysis. An initial correlation analysis of the 10 samples
shown in Fig. 5a indicated an acceptable linear relationship
with R = 0.81. The exclusion of the data points that cor-
respond to the typical samples PosPyr30, PAC300 and
BagP0.5 resulted in a greater correlation, with R = 0.92
(Fig. 5b). This improved correlation could be explained by
the fact that the typical samples PosPyr300 and PAC300
exhibit lower lacunarity values (i.e., 0.1758 and 0.1605,
respectively) but also exhibit fractal dimensions similar to
that of sample BagP0.5, which has a higher lacunarity
(0.2062).

Lacunarity analysis using the previously discussed values
(Table 1) showed that data sets extracted from complex
fractals exhibited little pattern change, i.e., they exhibited
similar fractal dimensions. In addition, homogeneous tex-
tures exhibit low lacunarity. However, when spatial hetero-
geneity features increase slightly, lacunarity values also tend
to increase. In some instances, fractal dimensions and lacu-
narity values are correlated, in agreement with previously
published work (Armatas et al. 2002; Przemyslaw 2009).

When the fractal dimensions from mercury analysis
were correlated with the lacunarities from SEM data, no
significant correlation was observed when all of the sam-
ples were considered. However, for some subsets of data, a
correlation was found (see Fig. Se, f). This correlation may
be related to the facts that lacunarity is representative of a
transept of the porous medium and that the surface
behaviour is maintained on the inside of the porous med-
ium only in some cases.

Another issue is that such quantities measured in the
external portion of a porous material are expected to bear
some relationship with those measured in the interior of the
material. The micrograph images (Figs. 1, 2) clearly rep-
resent part of the outer surface of the porous media;
therefore, the minimum and average pore sizes have a
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direct influence on transport of molecules inside the solid.
This minimum pore size interval was detected using both
the mercury porosimetry method and the method of SEM
image analysis. Therefore, the minimum pore size can be
calculated for all of the samples.

In the cases of the PosPyr300 (Fig. 1), VetPl.5,
BagP0.5, BagP1 and VetP0.5 activated carbon samples
(Fig. 2), the range of the outer surface pore size determined
using SEM analysis matches with the almost total interval
described by the mercury porosimetry PSD (Figs. 3, 4).
However, these coincidences do not indicate that the pore
sizes determined from the SEM images represent the entire
interval of pore sizes found in the interior of the porous
material.

The fractal dimensions obtained using mercury porosi-
metry (Table 2) between 2 and 3 correspond to a 3D
dimension because mercury is introduced inside the porous
material and is capable of filling the 3D complex structure.
In this case, the fractal dimensions for each carbon sample
are significantly different. However, in view of the com-
plex surface patterns that can be reproduced inside the
porous materials, some degree of correlation between
the Dggyy, the D, and the lacunarity is expected to be
observed. The set of carbon samples studied showed an
acceptable correlation for fractal dimension and lacunarity
(see Fig. 5). This result may indicate that, in such cases, the
surface texture is similar to the internal structure. On
the other hand, in some cases, SEM analysis showed that
the pores were not reached by the mercury in the mercury
porosimetry method. In the cases of PAC300, VetPl,
PACI120, PAC20, and PosPyr300, the pore sizes indicated
by analyses of SEM images were lower than those obtained
by mercury porosimetry.

In both cases, the information provided by SEM is
clearly insufficient by itself to characterise the sample
texture. However, complementary information about the
pore structure can be obtained. Lacunarity, for example,
is a value that cannot be obtained from mercury poros-
imetry. The fractal dimensions obtained from SEM
images characterise only the outer pore surface, whereas
the mercury porosimetry fractal dimensions describe the
tridimensional internal features. However, the exterior
surface characteristics are expected to be imitated inside
the pores, although these characteristics cannot be com-
pletely represented by a 2D image of the pores. The
acceptable correlation between the fractal dimensions
obtained from mercury porosimetry and those obtained
from SEM analysis (Fig. 5) may indicate that the internal
pore structure is a continuation of what is displayed on
the surface. The textural analysis performed via the
processing of SEM data could consequently be used to
guide various stages in the activation process of active
carbons.
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Fig. 3 Pore-size distributions of carbon samples based on mercury porosimetry measurements
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Table 2 Parameters calculated from mercury porosimetry: com-
pressibility and fractal dimension of the porous surface

Carbon Compressibility Fractal dimension
sample 10-12 m® kg~ Pa~! Dyoro
PosPyr300 1.45 2.2398
PosPyr400 1.5037 2.0398
PAC20 1.4615 2.3555
PACI120 1.3626 2.3557
PAC300 1.3551 2.2346
VetP0.5 1.4024 2.7389
VetP1 2.828 2.5416
VetP1.5 2.8034 2.7680
BagP0.5 2.0755 2.8407
BagP1 3.5716 2.7251

4 Conclusions

The need to use both direct and indirect methods for texture
analysis was demonstrated in this paper. The differences
observed between the PSDs determined using SEM and
that determined using mercury porosimetry were expected
because mercury can reach the deep pores inside the carbon
samples, whereas SEM provides only an image of the
surface features. However, a coincidence occurs in at least
some pores, as shown by the relationship between the
fractal dimensions and the lacunarities obtained from
the analysis of SEM images using the ImagelJ software. The
correlation between the fractal dimensions obtained from
mercury porosimetry and those obtained from SEM anal-
ysis indicates that the internal pore structure is a continu-
ation of what is displayed on the surface.
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